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Prop. Directional Control Valve
Operation Manual Series D*FB / D*1FT

Note

This document and other information from Parker-Hannifin Corpora-
tion, its subsidiaries and authorized distributors provide product or
system options for further investigation by users having technical
expertise.

The user, through its own analysis and testing, is solely responsible for
making the final selection of the system and components and assuring
that all performance, endurance, maintenance, safety and warning
requirements of the application are met. The user must analyze all
aspects of the application, follow applicable industry standards, and
follow the information concerning the product in the current product
catalog and in any other materials provided from Parker or its subsidi-
aries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors
provide component or system options based upon data or specifica-
tions provided by the user, the user is responsible for determining that
such data and specifications are suitable and sufficient for all applica-
tions and reasonably foreseeable uses of the components or systems.
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Prop. Directional Control Valve

Operation Manual Series D*FB / D*1FT
1. Introduction
D*FB
_" o fli“r
Ordering Code D*FB
Direct. Nominal Spool- Design Seal Command- Option Design Design
control  size type NBR signal series
valve (see (different seal
catalogue) compound by
request)
Code | Nominal size
1 |NGO06/CETOP 3
3 |[NG10/CETOP 5
Code Design
Spool/sleeve
0 .
design
a Spool/body
Code Design design
c a|O0|b
E a 0 Code Command Function Connection Option
signal
FO 0..+/-10V | 0...+410V > P-A 6 + PE Pot.-supply
K 0|l b SO 4..20mA |12..20mA >P-A| 6+ PE -
Pot.-supply &
0..+/-10V | 0...+10V > P-A
1)
WSl 4 20mA |12..20mA>p-a| 1+PE | command preset
channel

" Factory set +/-10V
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Ordering Code D*1FT

eI LA T L el [ L LI

Direct. NGO06 Integr. Flow Pilot Command Valve
control pilot electronics connection signal accessories
valve
Nominal Proportional Spool Spool Seal Option Design
size control type position NBR series
(other seal
compound
on request)
Code Nominal size Valve
Code .
3 | NG10/CETOPO5 accessorles
4 | NG16/CETOPO7 0 Standard
9* | NG25/CETOPOS 8 Monitor switch
* with enlarged connections
@ 32 mm
Code Spool type Code Inlet Drain
1 internal | external
E01 'A‘”lll 2 external | external
PT 4 internal | internal
E02 '{ Ill 5 external | internal
Q. =Q,/2
B31 \A N3
P
Q,=Q,/2
B32 \VALES -
DAL“ Code Corpmand Function Cor_mec Option
— signal tion
FO | 0..x10V | 0..+10V >P-B | 6 + PE | Pot.-supply
Flow [Vmin] MO | 0..x10V | 0...+410V > P-A | 6 + PE | Pot.-supply
ow [I/min
Code | at Ap = 5bar per metering edge SO | 4..20mA |12..20mA > P-A| 6 + PE -
D31 D41 D91 GO |0...+20mA |0...+20mA > P-B| 6 + PE —
C 75 - - Pot.-supply
0..x10V | 0..+10V > P-A & command
F - 200 - W5 1 4" 20mA [12..20mA > P-A| T T PE| T preset
H - - 400 channels
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Parker D*FB/D*1FT proportional directional control
valves have an integral electronic and requires only
one sole electrical common for the control system.
Different flow sizes, as well as command signal op-
tions are available to achieve an optimal adaption
for different applications.

Name Plate Example

D1FB Made in Germany

D1FBEO1CCONFO00-10
T

.'".'-lll.':ll- max. P, A, B
|_'250bar max. T
A B

hydr. spool symboll
nominal pressure
supply voltage
order code

Characteristics of Valve Driver

The described integral electronic driver combines

all necessary functions for the optimal operation of

the valve. The most important features are:

* digital circuit design

* high dynamic constant current solenoid con-
trol

» (differential input stage with various command
signal options

* four quadrant ramp function

* MIN adjustment for deadband compensation

* MAX adjustment to match the command signal
span to the valve operating range

* optional reference outputs +/-10 V for potenti-
ometer supply

* optional four parametrizable preset recall
channels

* standard central connection

* compatible to the relevant European EMC-
standards

* comfortable interface program

3
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Block Diagram of Integral Electronics
Code FO/MO (6+PE)

command e‘

0...+-10V

potentiometer ‘

supply
+10V @
®

-10v

Boe) ——— —©--
€9
18...30V=
Code S0/GO (6+PE)
T
1
®
|
|
\‘
"
boe) 9
Ce®
18...30V=
Code W5 (11+PE)
S1 S2 S3 sS4
R Cllo
\
®
0..4-10V o‘lﬂ uc

+10V

©
oV @
_

= supply
voltage

18...30V=
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Technical Data

Mounting Pattern

General

Model Proportional directional control valve, direct operated (D*FB), pilot
operated (D*1FT)

Drive Proportional solenoid

NG6 (CETOP 3) / NG10 (CETOP 5)
NG16 (CETOP 7) / NG25 (CETOP 8)

Installation Position Any
Hysteresis D1FB*0/D3FB*0 [%] [< 4
D3FB*3/D*1FT [%]|<5
Ambient Temperature Range [°C] | -20...+60
Protection Class NEMA 4 (IP 65) acc. EN 60529
Vibration Strength [G] [ 10 Sinus 5...2000 Hz acc. IEC 68-2-6
30 Random noise 20...2000 Hz acc. IEC 68-2-36
15 Shock acc. |IEC 68-2-27
Weight [kg] | NG6: 3/ NG10: 7/ NG16: 11/ NG25: 19.5
Hydraulic
Fluid Rate Hydraulic oil acc. DIN 51524...535, other on request
Viscosity [SSU] | 140...370
Fluid Temperature [°C] | -20...+60
Cleanliness Purity level class acc. NAS 1638: class 7
Operating Pressure max. (D*FB) [bar] | 350 for ports P, A, B / 210 for port T
Pilot oil intern (D*1FT): [bar] | 350 for ports P, A, B, X/ 105 for T, Y
Pilot oil extern (D*1FT): [bar] [ 350 for ports P, A, B, T, X / 105 forY
Electrical
Duty Ratio % | 100
Supply Voltage Us VDC | 18...30, ripple < 5% eff., surge free
Current Consumption max. A |D1FB:1.5/D3FB:2.0/ D*1FT: 1.5
Pre-Fusing A |D1FB:2.0/D3FB:2.5/D*1FT: 2.0
Potentiometer supply Up V|+£10/+5 % max. 10 mA
Command Signal Options Uc V | Codes FO, MO, W5: +10...0...-10, ripple < 0.01 % eff., surge free,
Ri = 100 kOhm
lc mA | Codes SO & W5: 4...12...20, ripple < 0.01 % eff., surge free,
Ri =200 Ohm
< 3.6 mA = enable off, > 3.8 mA = enable on (acc. NAMUR NE43)
mA | Code GO: +20...0...-20, ripple < 0.01 % eff., surge free,
Ri =200 Ohm
Differential Input Voltage max. V | Codes F0O, M0, SO, GO: 30 for terminal D and E against PE (terminal G)
V | 11 for terminal D and E against OV (terminal B)
V | Code W5: 30 for terminal 4 and 5 against PE (terminal PE)
V | 11 for terminal 4 and 5 against OV (terminal 2)
Channel Recall Signal Uch V| 0...2.5: Off / 5...30: On / Ri = 100 kOhm
Adjustment Ranges Min % | 0...50
Max % | 50...100
Ramp s|0..32.5
Interface RS 232C, parametrizing connection 5pole
EMC EN 61000-6-2, EN 61000-6-4
Central Connection Codes FO, MO, SO, GO: 6 + PE acc. EN 175201-804
Code W5: 11 + PE acc. EN 175201-804
Cable Specification mm?2 | Codes FO, MO, SO, GO: 7 x 1.0 (AWG16) overall braid shield
mm? | Code W5: 11 x 1.0 (AWG16) overall braid shield
Cable Length max. m | 50
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Prop. Directional Control Valve
Series D*FB / D*1FT

2. Safety Instructions

Please read the operation manual before instal-
lation, startup, service, repair or stocking! Paying
no attention may result in damaging the valve or
incorporated system parts.

Symbols

This manual uses symbols which have to be fol-
lowed accordingly:

Q Instructions with regard to the warranty

Instructions with regard to possible
damaging of the valve or linked system
components

> Helpful additional instructions

Marking, Name Plates

Instructions applied on the valve, i.e. wiring dia-
grams and name plates, must be observed and
maintained legibly.

Work at the Valve

Workings inthe area of installation, commissioning,
maintenance and repair of the valve may only be
allowed by qualified personnel. This means persons
which have, because of education, experience and
instruction, sufficient knowledge on relevant direc-
tives and approved technical rules.

3. Important Details

Intended Usage

This operation manual is valid for proportional
directional control valves D*FB/D*1FT series. Any
different or beyond it usage is deemed to be as not
intended.The manufactureris notliable for warranty
claims resulting from this.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

Common Instructions

We reserve the right for technical modifications of
the described product. lllustrations and drawings
within this manual are simplified representations.
Due to further development, improvement and
modification of the product the illustrations might
not match precisely with the described valve. The
technical specifications and dimensions are not
binding. No claim may resulting out of it. Copyrights
are reserved.

Liability
The manufacturer does not assume liability for
damage due to the following failures:

¢ incorrect mounting / installation

¢ improper handling

* lack of maintenance

e operation outside the specifications
Do not disassemble the valve! In case of
suspicion for a defect please return the valve
to the factory.

Storage

In case of temporary storage the valve must be
protected against contamination, atmospheric ex-
posure and mechanical damages. Each valve has
been factory tested with hydraulic oil, resulting in
protection of the core parts against corrosion. Yet
this protection is only ensured under the following
conditions:

Storage .
period Storage requirements
constant humidity < 60% as well
12 months o
as constant temperature < 25°C
6 months varying humidity as well a})s
varying temperature < 35°C

Outdoor storage or within sea and tropical
climate will lead to corrosion and might disable
the valve!

9 Parker Hannifin Corporation
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4. Mounting / Installation
Scope of Supply

Please checkimmediately after receiving the valve,
if the content is matching with the specified scope
of supply. The delivery includes:

e valve
* operation manual

The central connector assembly as well as the
parametrizing cable has to be ordered separately
and are not included in the delivery.

> Please check the delivery immediately after
receiving the shipment for apparentdamages
due to shipping. Report shipment losses at
once to the carrier, the insurance company
and the supplier!

Mounting

* Compare valve type (located on the name plate)
with part list resp. circuit diagram.

¢ The valve may be mounted fix or movable in
any direction.

* Verify the mounting surface for the valve. Une-
veness of 0.01 mm/100 mm, surface finish of
6.3 pm are tolerable values.

> Keep clean valve mounting surface and work
environment!

¢ Remove protection plate from the valve moun-
ting surface
* Check the proper position of the valve ports
and the O-rings.
* Mounting bolts:
D1FB: 4 pcs. M5x30
D3FB: 4 pcs. M6x40
D31FT: 4 pcs. M6x40
D41FT: 2 pcs. M6x55 / 4 pcs. M10x60
D91FT: 6 pcs. M12x75
use property class 12.9, DIN 912

Parker offers bolt kits:
D1FB: BK375, D3FB: BK385
D31FT:BK385,D41FT:BK320,D91FT:BK360
* Tighten the bolts crisscross with the following
torque values:
D1FB: 7.6 Nm/D3FB: 13.2 Nm
D31FT: 13.2 Nm, D41FT: 13 (63) Nm, D91FT:
108 Nm

Insufficient condition of the valve mounting
surface migth create malfunction!

Incorrect mounting resp. bolt torque may
result in abrupt leakage of hydraulic fluid on
the valve ports.

Operation Limits

The valve may be operated within the determined
limits only. Please refer to the “technical data“ sec-
tion as well as to the “characteristic curves” in the
catalog.

Follow the environmental conditions! Unallo-
wable temperatures, shock load, aggresive
chemicals exposure, radiation exposure,
illegal electromagnetic emissions may result
in operating trouble and may lead to failure!
Follow the operating limits listed in the “spe-
cifications*” table!

Pressure Fluids

The following rules applies for the operation with
various pressure fluids:

The above information serves for orientation
and does not substitute user tests among the
particular operating conditions. Particularly no
liabiliy for media compatibility may be derived
out of it.

mineral oil usable without restriction
HFA oil-in-water emulsion consultation required
HFB water-in-oil emulsion consultation required
HFC aqueous solution (glycols) consultation required
HFD unhydrous fluids (Phosphor-Ester) consultation required

> Fordetailedinformation concerning pressure
fluids note VDMA-document 24317 as well
as DIN 51524 & 51502.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

Special gaskets may be available depending
on the utilized fluid.

In case of insecurity please consult the fac-
tory.
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Electrical Connection

The electrical connection of the valve takes place
by one common cable, which is coupled to the
integrated electronic driver by a central connector
assembly.

The connection Codes FO/SO requires a 6 + PE
female connector EN 175201-804.

328.6
f
T
I
|

> The female connector has to be ordered
separately under article nr. 5004072.

A female connector with metal housing is
required! Plastic made models may create
function problems due to insufficient EMC-
characteristics.

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible,
7 conductors, overall braid
shield
Cross section min. AWG16/1.0 mm?
Outer dimension 8...12mm
Cable length max. 50 m

> For cable lengths > 50 m consult factory.
The connection cable is coupled to the female

connector by solder joints.
Skinning lengths for the connecting cable:

I

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

The connection Code W5 requiresa 11 + PE female
connector EN 175201-804.

max. 91

> The female connector has to be ordered
separately under article nr. 5004711.

A female connector with metal housing is
required! Plastic made models may create
function problems due to insufficient EMC-
characteristics.

The connecting cable has to comply to the follow-
ing specification:

Cable type control cable, flexible,
11 conductors, overall braid
shield
Cross section min. AWG16/1.0 mm?
Quter dimension 12...15mm
Cable length max. 50 m

> For cable lengths > 50 m consult factory.

The connection cable is coupled to the female
connector by crimp contacts.

Skinning lengths for the connecting cable:

I

> For the workmanlike termination of the crimp
contacts the tool # 932 507-001 — supplier:
Hirschmann — is required.

Do not disconnect cable socket under tensi-
on!

11 Parker Hannifin Corporation
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The shielding has to be assembled according the
outline below:

shield

b=zl

contact metal ring seal insert backshell
insert nut

The backshell nut of the cable gland has to be
tighten with a suitable tool. The target value for the
tightening torque is 4 Nm. Tighten the cap nut with
a torque of approx. 5 Nm after attaching the female
connector on the socket outlet.

Incomplete tightening of backshell nut resp.
cap nut may result in automatic release of
the connection as well as degradation of the
water tightness.

Follow the “instructions for use”forinstallation
of female connectors made by other kind of
brands!

The cable connection to the female connector
has to take place by qualified personnel! A
short between individual conductors resp. to
the connector housing, bad soldering as well
as improper shield connection may result in
malfunction and breakdown of the valve.

The mounting surface of the valve has to be
carefully tied to the earth grounded machine
frame. The earth ground wire from the valve
connecting cable as well as the cable shield
have to be tied to the protective earth terminal
within the control unit. It is necessary to use
a low ohmic potential connection between
control unit and machine frame to prevent
earth loops (cross section AWG 6).

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

Electrical Interfacing

Supply Voltage:
The supply voltage for the valve has to cover the
range of 18...30 V. The residual ripple may not
exceed 5% eff.

The applied power supply must comply to the
relevantregulations (DIN EN 61558) and must
carry a CE-mark. The operating voltage for
the valve must be free of inductive surges. Do
not exceed the max. value of 30V! Non-ob-
servance of this rule may result in permanent
damaging of the valve.

The increased inrush current of the valve
should be considered when selecting the
power supply. A stabilized power supply with
overcurrent limiting feature should not be
used.Duetotheinrushcurrentofthe valve the
current limit circuit may respond prematurely
and create problems during energizing of the
supply voltage.

The operation of the valve is blocked if the
supply voltage polarity is interchanged.

Each valve requires a separate pre-fuse (ra-
ting: s. techn. data). Non-observance of this
instruction may create irreparable damage of
valve resp. incorporated system parts.

B> D
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Wiring diagram of supply voltage
Code FO/M0/S0/GO (6 + PE)

control system

valve

Ed

Code W5 (11 + PE)

oV

18..30V |

Ed

—=

el

Command signal input:

The command signal for the valve will be connected
to the difference signal input of the electronic driver.
The solenoid current behaves proportional to the

Incorrect signal amplitude levels may disturb
the functionality and can damage the valve.

command signal amplitude. Different versions of > Theoption4...20 mA usesthe “0 mA“condition

command signal processing are available, depend-
ing on the valve type. These are described below:
For the function description is assumed as signal
reference (OV):

Code FO/M0/S0/GO: pin E, Code W5: pin 5

> Details are shown from the technical specifi-
cations.

The command input signal needs to be filtered
as well as free of inductive surges and mo-
dulations. Due to the sensitivity of the valve a
high signal quality is recommended, this will
prevent malfunction.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

as breakdown-information. This means the
presence of an evaluable failure information
if the input signal line is interrupted. In this
case the actuator drive will be switched off.
The drive will switch on when the input signal
reaches a value of 3.8 mA, it switches off
when the command falls below 3.6 mA. This
determination follows the NAMUR-specifica-
tion NE43.

NAMUR is an association of users of process
control technology.

Parker Hannifin Corporation
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Wiring diagram of voltage command input +10...0...-10 V Code F0/MO (6 + PE)

valve

control system

cpmmand } '
signal i

command signal function
U pE T J
0..+10V >
U pE )@ _
oV Ol D*FB*FO
U D-
o...-1DoEv ><
function
I { %8% D*1FT*FO
function
A P
>< Ol D*1FT*KO

Wiring diagram of voltage command input +10...0...-10 V via potentiometer Code FO/MO (6 + PE)

control system

*********** bl

valve

The external potentiometer is

potentiometer
command signal

+10V

-10V

1608

@
O
®)

/ i N
1 \ \
! \ \
I ! '
I " 1
| |

s
H T
|
i

fed via the output “potentiometer
supply”.To prevent this output from
overload, the resistance value
of the potentiometer should be
within a range of 5...10 kOhm. A
nominal power rating of 0.1 W is
sufficient.

©
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Wiring diagram of voltage command input +10...0...-10 V

Code W5 (11 + PE)

control system valve
T —— \
command } ' ! ' command signal function
signal \ / / @ I 45
Uc < > )
e O O O 0..+10V
,,,,, >
OO OO I 45 O D*FB
ov IO
O O O | 45 ><
0..-10V
function
) @¢ .
D*1FT
} l IO
Wiring diagram of voltage command input +10...0...-10 V via potentiometer
Code W5 (11 + PE)
77777 c grLtrgI system valve
- b
potentiometer }
command signal Us pmpmmmm———— :
== Y \ command signal function
I ! \ \
+10V -0V ! \ \ U 45
U ' 1 ‘: 0..+10V >
‘ | i ! U 45 )OI D'FB
\ Vo : ov IO
I | ! ! U 45 ><
L ! 0..-10V
,,,,,,,,,,,, I function
)H( .
D*1FT
l l IO
Wiring diagram of current command input +20...0...-20 mA Code GO (6+PE)
valve
O command signal function
I D-E
control system O 2O\ | o.+20ma ><
 —— - O DE | | X
e ; —® ~ O D*1FT*GO
command R \ | OmA )@)€
N —> 1 I |
signal Loy | I D-E
(e = . 0...-20mA
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Wiring diagram of current command input 4...12...20 mA
Code SO (6 + PE)

control system

command r—— | !
signal (.

Wiring diagram of current command input 4...12...20 mA
Code W5 (11 + PE)

control system valve
oS,
oI
lc F—————— . @
P OO
oeJele;
Olel®
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command signal function
| DE
12...20 mA
I D-£ )@
12 mA > IO
| D-E
4.12mA ><
| DE actuator
<3.6 mA drive off
| DE actuator
> 3.8 mA drive on
command signal function
| 45
12...20 mA
| 45 )@
12 mA > IO
| 45
4..12 mA ><
| 45 actuator
<3.6 mA drive off
I 45 actuator
> 3.8 mA drive on

—Parkor *
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Recall channels for internal command preset

Up to six corresponding inputs are provided for
channel recall of internal command presets. The
conjunction

options of the internal command channels may be
selectable via the parameter E21. The following
options are

provided:
* priority dependent
* additive

At priority dependent channel recall the channel
with the lowest numerical designation has priority
against other

simultaneously adressed preset channels.

Example: Channels S1, S2, S3 are adressed.
Channel S1 has priority, the corre-
sponding internal command will be

assessed as input signal.

The presetchannels have priority againstthe analog
signal input for the external command.

Wiring diagram of recall channels
Code W5 (11 + PE)

Atadditive channelrecall the internal signal presets
of the recall channels as well as a possible signal
at the external signal input will be added. The sum
of the signal values is limited at 100%.

Example 1: Channel S1=+50%, channel S2=+20%,
externalinputsignal=+5V (=+50%).The
sum s +120%, in this case +100% input
signal will be assessed.

Example 2: Channel S1=+50%,channel S2=+20%,

external input signal = -5V (=-50%). The

sum is +20%, in this case +20% input
signal will be assessed.

The preset channels are switched through during
the signal trigger at the dedicated inputs.

> More details are shown from the technical
data.

The channelrecall signals needs to be filtered
as well as free of inductive surges and modu-
lations. To prevent malfunctions a high signal
quality is recommended.

valve cmd. recall signal int. command
o Ues2 <25V S 1 off
Use2 >5..30V S1 on
control system U772 <25V S 2 off
U72 >5.30V S2 on
Usz <25V | »| S3 off
Us2 >5.30V S3 on
S 4 Utt2 <25V S 4 off
internal Utt2 >5.30V S4 on
command S 3
recall S 2
signals
S 1
D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12
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5. Operating Instructions

Basically the valve performs the task of convertinga
command signal into a proportional spool stroke with
the highest possible dynamic. For these purposes
the input value will be electronically processed and
provides via a power amplifier stage the required
current for the valve solenoid.

ProPxD parameterizing software:

The ProPxD software permits comfortable param-
eter setting for the module electronic.Viathe clearly
arranged entry mask the parameters can be noticed
and modified. Storage of complete parameter sets
to floppy or hard disk is possible as well as printout
or record as a text file for further documentation.
Stored parameter sets may be loaded anytime and
transmitted to other valves. Inside the electronic a
nonvolatile memory stores the data with the option
for recalling or modification.

Features
* comfortable editing of all parameters
¢ depiction and documentation of parameter sets

e storage and loading of optimized parameter
adjustments

» executable with all actual Windows® operating
systems from Windows® 95 upwards

* plaincommunication between PC and electronic
via serial interface RS-232.

Comfortable interface, see Parker freeware available
from infohcd @ parker.com.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

ProPXD screenshot

Hardware requirements

¢ PC with operating system from Windows® 95
upwards

* Interface RS-232
* display resolution min. 800 x 600

¢ connection cable between PC and electronic
module

e storage requirement approx. 4 MB

> ltis recommended to select “small fonts” at
the display setting, otherwise distortion of the
display may occur.

Cable Specification

The connection of the valve electronic to a PC
requires a special cable. It may be ordered under
code 40982923. The cable has to be inserted
between an unused serial port COM1 or COM2 of
the PC and the 5pole socket connector of the valve
electronic (parametrizing connector).

> Before connecting of the parametrizing cable
a cover plug has to be removed from the
electronic housing.

Attention! The valve electronic provides no
USB interface, but can only be parametrized
via an RS-232 - connection. Therefore the
usage of USB standard cables is permitted
and may resultin damaging of valve resp. PC.

18 Parker Hannifin Corporation
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Parametrizing connection

cover plug
parametrizing connection

Program installation

Please check before installation if the above hard-
ware requirements are met. If your PC has already
stored an older version of the “ProPxD” program,
it has to be deinstalled by using the Windows® -
system control feature.

Program installation sequence:

* terminate the execution of other programs
* insert ProPxD-software CD

* execute the file “setup.exe”

* follow the instructions on the screen

Answer the question, if an older version should be
overwritten, with “ok”. During the installation you
may change destination drive resp. installation
path, if needed (i.e. if the storage space on drive
“c” is not sufficient).

Please answeralso“ok”if atthe end of the installation
the program reports any system information. After
successful installation the desktop display shows
the ProPxD icon for starting the program.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

Parametrizing cable 40982923

SubD 5 pole
9 pole male plug
female plug

5 GND GND 5
2 RXD X RXD 3
3 XD TXD 4

PC side connection

valve side connectior

The cover plug has to be re-installed after
completion of the parametrizing work.

Software Operating
Brief instruction for first startup:

Connectthe valve electronic to the supply voltage.

Connect the valve electronic to a PC via the
parametrizing cable.

Click on the ProPxD icon to start the operating
program.

After displaying the program resp. data base
version a program window opens and the con-
nected valve will be automatically identified
(possibly a manual identification via the button
“Receive all’ is necessary).

Select the desired version via the menu “Op-
tions/Optionen” with the menu item “Language/
Sprache”.

The valve specific default parameters are already
available within the parameter table.

Individual parameters may be selected via
mouse or the arrow buttons at the center of the
program screen.
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Parameter changes are possible via mouse or
the arrow buttons on the bottom left within the
program screen, also the parameter values may
be edited via the keyboard.

Modified parameters will be stored via the “Enter’
key or via the button “Update list”.

After completing of all modifications, the entire
parameter set may be transmitted to the valve
via the button “send all”, also the parameters
will be nonvolatile stored.

»”

The chosen parameters may be optionally stored
onthe PC via the “File”-menu with the menuitem
“Save as”, data retrieving is always possible via
the function “Load out of database”

Extended functions:

The user software is shared into 2 parameter
ranges:

basic mode
expert mode

For normal startup the basic mode is absolutely
sufficient. It permits the setting of all application
specific parameters to match the valve function
with the task setting.

In case of special applications the valve parameters
may be adapted via the expert mode.

The operating mode may be selected from the
“Options”- menu and remains after terminating and
re-start of the program.

Changing of expert parameters is only permit-
ted for qualified personnel. Incorrect settings
may lead to malfunction! In case of parameter
changes shut the drive down!

To prevent an unauthorized access for the expert
mode, a pass word is requested. The name is
“parker” and cannot be changed. Thus additionally
to the button “Default” for loading of the default
parameters, the button “Send parameter” appears
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to
the connected valve. Thus a quick tuning of single
parameters is permitted during the setup.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12

> A horizontal bar graph readout between
the communication buttons shows the data
transfer state.
> Becausethe ProPxD program has also offline
(i.e. without connection to the valve) function-
ality, amanual pre-selection of the parameters
is possible. After selection of the valve type
via the menu “Options” the parameters may
be set and stored for later transmission.
Note the design series while selection of the
valve!

The “File” menu provides the functions “Printer
setup”, “Print preview” and “Print”. The print preview
includes the option for parameter set storage as
text file (format .ixt) prior to further processing. The
“Options” menu provides also the selection of the
RS-232 interface port via the menu item “Port”. Via
the menu item “Load out of database” previously
stored parameter sets may be loaded.

Adjustment parameters

The available parameters may be divided into
multiple groups and are characterized by different
letters:

S-parameters
P-parameters
E-parameters
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Parameter overview for basic mode

Parameter Description Unit Parameter Range Defa_ult Comment
from up to Setting

S1 internal Sollwert S1 % -100 100 0.0

S2 internal Sollwert S2 % -100 100 0.0

S3 internal Sollwert S3 % -100 100 0.0 code WS only
S4 internal Sollwert S4 % -100 100 0.0

S5 ramp accel. channel A | ms 0 32500 0

S6 ramp decel. channel A | ms 0 32500 0

S7 ramp accel. channel B | ms 0 32500 0

S8 ramp decel. channel B | ms 0 32500 0

P3 MAX channel A % 50.0 100.0 100.0

P4 MAX channel B % 50.0 100.0 100.0

P7 MIN channel A % 0.0 50.0 0.0

P8 MIN channel B % 0.0 50.0 0.0

P11 polarity command - 0 1 0

. 1==x10V
E17 option command = 3 = 4-20mA 1= 10V | code W5 only
E19 cable (t:;fnarlr(] éilr?(tjectlon B 0 10==4 _12100n\1/A 0= +/-10V codesoiﬁl & W5
. 0=1%
E25 MIN operating threshold| — 0=1%
1=0.01%
D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12
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Individual Description of Basic Parameters

S1
command signal S1
S2
command signal S2
S3
command signal S3
S4
command signal S4
S5
ramp accel. channel A
S6
ramp decel. channel A
S7
ramp accel. channel B
S8
ramp decel. channel B
P3
MAX +
P4
MAX -

P7
MIN +
P8
MIN -

P11
command signal polarity
E17
type of command signal
device
E19
cable break detection
command
E25
MIN operating threshold

Adjustment of the internal command signal channel S1.

To attenuate of an external accessible command signal.

Adjustment of the internal command signal channel S2.

To attenuate of an external accessible command signal.

Adjustment of the internal command signal channel S3.

To attenuate of an external accessible command signal.

Adjustment of the internal command signal channel S4.

To attenuate of an external accessible command signal.

Adjustment of ramp rate for increasing of the positive signal polarity.
To avoid switching noise.

Adjustment of ramp rate for decreasing of the positive signal polarity.
To avoid switching noise.

Adjustment of ramp rate for increasing of the negative signal polarity.
To avoid switching noise.

Adjustment of ramp rate for decreasing of the negative signal polarity.
To avoid switching noise.

Adjustment of maximum signal span for positive output signal.

To match the command signal span to the valve operating range.
Adjustment of maximum signal span for negative output signal.

To match the command signal span to the valve operating range.
Adjustment for positive output signal step at 0,1% command signal.
To compensate for the overlap of the valve spool.

Adjustment for negative output signal step at 0,1% command signal.
To compensate for the overlap of the valve spool.

Adjustment of the command signal polarity.

To match the command signal polarity to the valve operating direction.
Adjustment of the command signal option.

To match the command signal input to the input signal mode.

Adjustment of the operating mode for the command cable break
detection. To turn on resp. off of the cable break detection of the
command signal at a selected command signal option of 4...20 mA.
Adjustment of the MIN operating threshold.

To match the response sensitivity for the MIN-stroke step.

D_FBobe & D_1FTobe_12-40 5715-644 UK.indd CM 05.06.12
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Parameter overview for expert mode

e Description Unit Parameter Range Default Setting| Comment
meter from up to
S11 | ramp for int. command S1| ms 0 32500 0
S12 |ramp for int. command S2| ms 0 32500 0
S13 |ramp for int. command S3| ms 0 32500 0
S14 |ramp for int. command S4| ms 0 32500 0
S17 default ramp ms 0 32500 0
P5 dither amplitude % 0 10.0 0
P6 dither frequency Hz 0 300 0
option internal command 0 = priority dependent 0 = priority
E21 . . . - .
signal conjunction 1 = additive dependent
0 = quadrant dependent
int. command signal (S5...8) 0 = quadrant | Code W5
E22 . - .
ramp function 1 = int. command depend. dependent only
(S11...14)
int. command signal 0 = standard _
e functionality 1 = special option DFL 0 = standard

Individual Description of Expert Parameters

S11
ramp for internal
command signal 1
S12
ramp for internal
command signal 2
S13
ramp for internal
command signal 3
S14
ramp for internal
command signal 4
S17
default ramp
P5
dither amplitude
P6
dither frequency
E21
internal command signal
conjunction
E22
internal command signal
ramp function
E83
internal command signal
functionality

Adjustment of the ramp rate for the internal command signal channel S1.
To avoid switching noise.

Adjustment of the ramp rate for the internal command signal channel S2.
To avoid switching noise.

Adjustment of the ramp rate for the internal command signal channel S3.
To avoid switching noise.

Adjustment of the ramp rate for the internal command signal channel S4.
To avoid switching noise.

Adjustment of the ramp rate for the default ramp.

To avoid switching noise.

Adjustment of dither amplitude.

To reduce the influence of solenoid friction.

Adjustment of dither frequency.

To match the dither signal to the valve dynamic.

Adjustment of the conjunction for the internal command signals.
To match the command signal logic.

Adjustment of the ramp function for the internal command signals.
To match the ramp functionality.

Adjustment of the functionality for the internal command signals.
To match for the special option DFL.
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Error messages

Malfunctions when using the ProPxD software program will be indicated via appropriate failure mes-

sages.

Failure messages and corrective actions:

Failure message

Description/corrective action

The Com Port is not available!

Unable to open COM port

There is no module/valve con-
nected or the communication
is disturbed! Please check
also the interface!

Wrong password

Wrong input

Keep the entered para-
meters?

The chosen module/valve
isn’t the same as the con-
nected hardware. Attention!
Unsaved parameters will be
lost.

The chosen hardware isn’t
the same as the connected
module/valve.

Attention! Factory settings
will be changed! Transmit
anyhow?

file name.pxd already exists.
Do you want to replace the
file?

Terminate the other program, or quit the message and select an-
other RS-232 port via the menu “Options > Port”. Afterwards recon-
nect the parametrizing cable.

Com port is not available. Quit the message and select another
RS-232 port via the menu “Options > Port”. Afterwards reconnect
the parametrizing cable.

No data exchange possible. Either the electronic has been re-
moved, the port is mismatched, or the connection will be disturbed
by strong electrical fields. Check if the Com port is set for “9600, 8,
1. none, none” via the menu “Options > Port”.

Retype the password, notice the exact spelling (case sensitivity).

An unvalid character or a value outside the permitted range has
been used at parameter entry.

During parameter loading from the electronics memory the preset
parameters from the left hand screen display may be rejected or
maintained.

In principle, parameters dedicated to a type which deviates from
the connected valve may be edited. However, for data transmitting
the correct valve has to be connected. If parameters will be loaded
from a valve which deviates from the selected one, the parameters
from the left hand side screen display of the program will be over-
written.

The wrong valve type has been selected from the database, after-
wards the function “send all” has been executed.

Default parameters has been read out from the database instead
from the valve via the function “receive all”.

The file name already exists within the indicated directory. Select
another name, another directory or overwrite the existing file with
“OK?”.
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Air Bleeding of Hydraulic System

During initial startup, after an oil change as well as
after the opening of lines or valves the hydraulic
system must be air bleeded. Air in the hydraulic
system is very disadvantageous and therefore
undesirable for the control system. The pipeline
network is vented at its highest point. The fitting
may be loosened a little so that the air can escape
with only a small amount of oil loss. When the oil
is no longer foaming, the fitting is re-tightened.
Afterwards all functions are run through, one after
the other, in no-load operation with low pressure
and with full cylinder stroke. Afterwards the system
should be vented once more.

After air bleeding the oil level in the tank must
be checked, and refilled as necessary!

Filter

The function and lifetime of the valve are strongly
affected by the cleanliness of the fluid.

Dirt is the greatest enemy of the hydraulic
system!

There are three important sources of dirt to watch
for:

¢ contamination arising during installation

e contamination arising during operation, friction
wear

¢ impurities from the environment

Basically a purity level class of 7 acc. NAS 1638
is required.

(&= Pay attention to maintenance details!

Flushing

Itisrecommended to flush the long pipelines by short
circuiting the pressure and return lines, especially
forlarge, central pressure oil stations. This prevents
the installation dirt from entering the valve.
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6. Maintenance

Service work may only be carried out by
qualified personnel. Detailed knowledge of
the machine functions concerning switching
on and off as well as of the required safety
relevant technical tasks is required!

Periodical maintenance is essential for the longevity
of the system and guarantees reliability and avail-
ability. The following properties of the system has to
be checked in continuous short time intervals:

¢ oil level in the tank
* max. working temperature

* condition of the pressure fluid (visual inspection,
colour and smell of hydraulic fluid)

* working pressure levels

e gas pre-load pressure on the pressure accumu-
lator

* leakage on all system components
* condition of filter elements

¢ condition of hose lines

¢ cleanliness of components

After a certain operating duration a change of the
hydraulic fluid is required. The frequency of change
depends from the following circumstances:

¢ kind resp. grade of the pressure fluid
o filtering

e operating temperature and environmental
conditions
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7.Trouble Shooting

Basis of troubleshooting is always a systematic For suspect of a sluggish spool the valve may

approach. At first the following questions have to be flushed with clean pressure fluid.

be checked:

« Are there practical experiences with similar Troubleshootingin a hydraulic system requires
failures? in either case a systematic approach.The work

may exclusively be performed by qualified
personnel, as it requires detailed knowledge
about function and construction of the system.
Reversals or dissassemblings may not be
taken imprudently! Prior to the works it has to
be clarified, if the system has been operated
properly until the failure occured.

* Have system adjustments been changed?

Afterwards starting of troubleshooting by means of
a priority list of the most likely reasons.

malfunction at hydraulic load runtime

- generally no function

- high frequent oscillation
- low frequent oscillation
- one way operation only
- speed variations at unchanging command
- different speeds depending on travel direction
- speed too low
- drifting without command
possible reasons for malfunction corrective actions
X hydraulic pump resp. motor defective replace hydraulic pump resp. motor
X X|x|[x|x]|x drive overloaded reduce pressure resp. speed, increase valve size
X x| x|x|x|x|x |valve contaminated clean pressure fluid, filter / flush valve
X X hydraulic fluid too viscous / too cold change fluid grade, provide operational temperature
X x| x too low oil level within tank refill pressure fluid
X[ x|x filter contaminated clean resp. replace filter
X X x | x |supply voltage too low keep supply voltage range
X supply voltage carries too much ripple reduce ripple
X X X command signal too low increase command signal
X command signal carries too much ripple reduce ripple
X dither signal amplitude too high reduce parameter P5
X dither signal amplitude too low increase parameter P5
x| x X x | x |central connector contact failure clean contacts resp. replace connector
X feed cable interrupted fix feed cable
X [x|[x|x]|x x | x |wiring sequence incorrect correct wiring sequence
X x |feed cable without shielding change cable grade
x) pilot flow configuration incorrect correct pilot flow configuration

7 only for D*1FT
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8. Accessories / Spare Parts

Accessories

The following accessories are available for the
valves series D*FB/D*1FT:

D1FB:

bolt kit

Code FO/M0/S0/GO:
female connector 6+PE
Code W5:

female connector 11+PE

D3FB:

bolt kit

Code FO/M0/S0/GO:
female connector 6+PE
Code W5:

female connector 11+PE

D31FT:

bolt kit

Code FO/M0/S0/GO:
female connector 6+PE
Code W5:

female connector 11+PE

D41FT:

bolt kit

Code FO/M0/S0/GO:
female connector 6+PE
Code W5:

female connector 11+PE

ordering code BK375
ordering code 5004072

ordering code 5004711

ordering code BK385
ordering code 5004072

ordering code 5004711

ordering code BK385
ordering code 5004072

ordering code 5004711

ordering code BK320

ordering code 5004072

ordering code 5004711

C3S S

Kaarst, Germany: Parker Hannifin GmbH
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DO1FT:

bolt kit

Code FO/M0/S0/GO:
female connector 6+PE  ordering code 5004072
Code W5:

female connector 11+PE ordering code 5004711

ordering code BK360

Spare Parts
The following spare parts are available:

D1FB:

seal kit NBR ordering code SK-D1FB-N
D3FB:

seal kit NBR ordering code SK-D3FB-N
D31FT:

seal kit NBR ordering code SK-D31FTN
D41FT:

seal kit NBR ordering code SK-D41FTN
DO1FT:

seal kit NBR ordering code SK-D91FTN

Kaarst, Germany: Parker Hannifin GmbH
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